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Guide Set up and use digital signature in PDF documents 

 

The following explanations refer to the setup with Adobe Acrobat Reader under 

Windows 10. If you use another PDF program or operation System, the procedure 

may differ. 

The document is divided into three sections: 

1. Set up digital ID/signature 

2. Adding the handwritten signature as Appearance 

3. Use digital ID/signature 

 

 

 

1. Set up digital ID/signature 

There are two different ways to set up the digital signature in Acrobat Reader. 

 

Option 1 

Step 1: You have already opened a form with a digital signature field. Click on the 

digital signature field. 

Certificates required for using digital IDs!!! 

In order to be able to use digital IDs in correspondence to sign documents, 

they must be stored with certificates. The certificates show that the signature 

or the document comes from the respective signer. This also protects the 

document from subsequent changes. If someone willfully edits the document 

later, the document loses its certificates and thus becomes invalid. 

Since there are various certificates that can be used, it must first be clarified 

which ones can be used at the university. The IT Service Center (ITZ) has 

already been contacted about this, but has not yet received an answer. As 

soon as it is clear which certificates can be used, this guide will be expanded 

to include a section explaining where and how these certificates can be 

obtained and how the digital IDs are stored with them. 
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Step 2: After clicking on the digital signature field, the following window will open: 

 

 

All available digital signatures are displayed in this area. Click “Configure New 

digital ID” to create a new signature. 

 

Step 3: In the following step you can choose, if you (1) use a device, e.g. a smart 

card, to create the signature, (2) import an existing ID or (3) create a completely 

new one directly in Adobe. 
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Select „Create a new Digital ID” and confirm with “Continue”. 

Step 4: You can then choose whether you want to save the digital ID as (1) a local 

file or (2) save it in the Windows Certificate Store. Create the digital ID as a local 

file. 

 

 

Step 5: In the following window, enter your data (name, organizational Unit, 

Organization Name, Email Address, country/region). For the Key Algorithm, keep 



 

4 

“2048-bit RSA” and under the item “Use Digital ID for” select “Digital Signatures 

and Data Encryption”. Confirm your entries with “Continue”. 

 

 

 

Step 6: Now you can specify the location of your ID. By default it is stored under 

the following path: 

C:\Users\’Name User Account’\AppData\Roaming\Adobe\Acrobat\DC\Security 

It is recommended to keep this path. 
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In addition to the storage location, you also specify the password with which you 

authenticate your digital ID for each signature. 

Confirm your entries with “Save”. 

Step 7: You will now see the selection screen for your digital signatures again and 

can use them to sign the documents provided for this purpose. 

 

 

 

 

 

Option 2 

Step 1: Open the settings (“Preferences”) via the menu at the top under the “Edit” 

tab. Alternatively, you can also access the settings using the shortcut Ctrl+K. 

 



 

6 

 

 

Step 2: If not done automatically, select the “Signatures” category. In the 

“Identities & Trusted Certificates” area, click on the “More…” button. 
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Step 3: You will see the following window with all existing digital ID’s. Click “Add 

ID” to create a new signature. 

 

 

Step 4: Similar to option 1 you can now choose whether you want to create a 

completely new ID or import an existing one. Select „A digital ID I want to create 

now” and confirm with “Next >”. 
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Step 5: Now you choose whether to create the ID as a local file or store it in the 

Windows Certificate Store. Select “New PKCS#12 digital ID file” to create a local 

file and confirm with “Next >”.  

 

 

 

Step 6: Now enter your Data (Name, Organizational Unit, Organization Name, 

Email Address, Country/Region). Select “2048-bit RSA” as key algorithm and the 

purpose of the digital ID. Confirm your entries with “Next >”. 
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Step 7: Now choose the location of the ID and enter your password. The default 

location for the ID is: 

C:\Users\’Name User Account’\AppData\Roaming\Adobe\Acrobat\DC\Security 

It is recommended to leave the default path. Once you have set up your password, 

confirm your information by clicking on “Finish”. 
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Step 8: You will now see your newly created digital ID in the overview. 

 

 

 

 

  



 

11 

2. Adding the handwritten signature as Appearance 

If you now want to use the digital ID for signing, usually only your name is 

displayed as text to the left of the signature, as shown in the following figure: 

 

 

To give the signature an individual touch and to make it recognizable as yours, 

you can display your handwritten signature instead of the text next to the 

signature. 

To add a handwritten signature to the appearance of the digital ID, you will need 

either a touch or pen-enabled device or an image of your signature in JPEG format 

(*.jpg). This can either be a scan of your signature or a signature created on a 

touch device with pen input. 

 

Preparation 

(Note: The following refer to adding the signature using an image. If you are using 

a device with touch or pen input, you can add your handwritten signature directly 

via the device without an additional image file. If you want to use this method, 

skip the following steps an start directly with the explanations for option 1 (see 

page 18)). 

 

Open a program, that can edit PDFs and export or save the edited file as a PDF, 

e.g. LibreOffice Draw or OpenOffice Draw. The following steps are explained using 

LibreOffice Draw as an example. 
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Paste your signature image into the workspace. If the image is not the right size, 

as shown in the image below, first crop the image so that the edges are smaller 

and the signature fills most of the image. 

 

 

 

To do this, right-click on the image and select “Crop”. 
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The frame of the image will then changes as shown in the image below.  Now crop 

the image to the right size by trimming the edges so that the signature takes up 

almost the entire image area: 

 

 

 

 

To leave the “Crop” mode, either click in an empty area next to the image or press 

the “Esc” key. 

Now set the page size to the dimensions of the image file and, if necessary, re-

center the image on the page so that it fills the entire page. You can find the 
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dimensions of the image when it is selected or marked in the properties under the 

"Position and size" tab. 

 

 

 

To resize the page/slide, right-click either the slide or the grey area next to it and 

select “Page Properties”. 

 

 

 

The following window will then open. Enter the dimensions of the image as the 

dimensions for the page. The orientation, i.e. whether portrait or landscape format, 

should be adjusted automatically. Confirm the information by clicking on “OK”. 
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After confirming the changes, you will probably first see a blank page. The reason 

for this is that the position of the image was not changed during the adjustment. 
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To find the image of your signature, zoom out further by holding down the Ctrl key 

and turning the mouse wheel until you can see the signature again. 

 

 

Drag the image onto the page. It should now fill the entire area. 

 

 

Export the file as a PDF. This can be done either directly via the toolbar above the 

work area to the left of the printer symbol or via the menu under the path “File → 

Export as → Export as PDF...”. 
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Give the file a suitable name and select the storage location where you can find it 

later. 
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This completes the preparation for inserting the signature. 

In the following there are two options to insert the PDF with your signature as an 

appearance. 

 

Option 1 

Step 1: If you have already opened a document with a digital signature field, click 

on the signature field and the following view will open: 
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Here you can see all usable digital IDs for the signature. Select your ID and click 

on “Continue”. 

 

Step 2: The preview for your signature will then appear. By default, your name is 

displayed in text form in the left area, as can be seen in the following image. This 

is the so-called appearance. 

 

 

You can now change the appearance or add a new one by clicking on “Create” in 

the upper right area of the window above the preview.  

 

Step 3: If you want to create a new appearance or edit an existing one, you get 

to the following window: 



 

20 

 

 

Here you can use the bar above the preview to select a form of display. The “Text” 

tab allows you to implement the familiar form of the standard view. If you are 

using a touch-enabled device, you can insert your handwritten signature directly 

via the “Draw” tab. If you are not using a device with a touch function, you can 

also add your signature using an image file via the “Image” tab. Under the “None” 

tab, you can set that only the right half of the signature is displayed. 

Now select the “Image” tab and click “Browse” under the preview to add your 

initially prepared image file to your signature. In the new window (see next figure) 

look for the saved PDF file of your signature and confirm the selection with “Open”. 
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Step 4: Once you have added your signature, you can still make various settings 

below the preview, what should be displayed on the right side of the signature, 

what alignment the text has and in what format the numbers are displayed. It is 

recommended to leave the default settings. In the lower left corner of the window, 

enter a name under “Preset Name” that you can use to identify the created 

appearance in the selection menu. Then confirm all entries by clicking on “Save”. 

 

 

Step 5: Once you have confirmed all entries, the setup of the new appearance is 

complete. When signing, you can now select your handwritten signature via the 

“Appearance” drop-down menu under the designation you previously specified, so 

that it is displayed next to the digital ID. 
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Option 2 

Step 1: Open the Adobe Acrobat Reader settings (“Preferences”) in the menu at 

the top of the program window via the “Edit” tab. Alternatively, you can also do 

this using the shortcut Ctrl + K. 
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Step 2: In the settings, select the "Signatures" category and click on the "More..." 

button in the "Creation & Appearance" section. 
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Step 3: To add the prepared image file to your signature, click on the "New..." 

button in the "Appearances" area. 
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Step 4: In the “Title” line, enter the name of the appearance under which you will 

find it later in the corresponding selection menu. Then select the “Imported 

graphic” item in the “Configure graphic” area and click on the “File...” button. In 

the window that appears, click on the “Browse...” button and select your signature 

saved as a PDF from the appropriate storage location. You can use the preview to 

see whether you have selected the correct file. Confirm the selection with “OK”. 
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Now you are back in the window with all settings. Under the “Configure text” and 

“Text properties” areas, you can set what content should be displayed in the 
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signature, what alignment it should have and the format in which the numbers 

should be displayed. It is recommended to keep the default settings. 

When you have made all the entries, confirm them by clicking on “OK”. 

 

Step 5: The creation of the new appearance is now complete. In the “Appearances” 

area you will now also find the new appearance under the name you specified. If 

you want to make changes to it later, select the relevant appearance and click on 

the "Edit..." button. 
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After you have created the new appearance, you can now find and select it under 

the name you chose during signature via the "Appearance" drop-down menu, as 

shown in the following images: 
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3. Use digital ID/signature 

The use of the digital signature is described using the example of the routing slip 

for the mandatory internship at the WIW department. The steps apply analogously 

to all other forms. 

 

Step 1: Fill in the required fields. 

 

 

Step 2: When you have entered the required data, click on the signature field. The 

following window appears: 

 

Select your signature and confirm with “Continue”. 
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Step 3: Select the appearance of the for the left section of the signature (e.g. 

“Standard text” or a handwritten signature). 

 

 

 

Enter the password or PIN for your digital ID in the field at the bottom left and 

confirm with “Sign”. 

 

Step 4: When you confirm the signature, a “Save as” window opens. This gives 

you the option to save the completed document separately with a name more 

appropriate for the recipient and keep the blank template with the original name. 

Save the completed and signed document under a new name. 
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Step 5: With the digital signature, all fields you have edited or filled out have now 

been locked so that they can no longer be changed later. 

 

 

 

Now email the completed document to the intended recipient. 

 

 

 

 

 

 


